
VoiceWalker
A discourse transcription utility

1. Introduction
VoiceWalker is designed to facilitate the transcription of recorded discourse by giving the 

transcriber efficient control over how sound is are played back. 

No longer is it necessary to choose between transcribing on a high fidelity tape deck for sound 
quality and audibility, or on a specialized foot-pedal transcription machine for convenience of playback 
control. VoiceWalker combines high-quality stereo sound provided by your computer with far more 
precise and flexible control over audio playback than even a dedicated transcription tape machine can 
provide. All is controlled by the transcriber from the computer keyboard (and/or mouse).

Audio quality matters because it gives a degree of accuracy and audibility that allows faster, less 
fatiguing, and more reliable transcription. It becomes indispensable for deciphering rapid speech, and 
especially for recognizing words when two speakers talk simultaneously. Precise playback control 
matters because it allows the transcriber to repeat identically any specified section, as many times as 
necessary to get it accurately transcribed. With VoiceWalker all key playback functions can be controlled 
by either the mouse or the keyboard (with function keys). This means the transcriber’s hands never have 
to leave the keyboard, facilitating use of a word processor for doing the transcription.

The simplest way to begin learning to use VoiceWalker is to just try it out: click on all the buttons 
and see what happens. Just about all the buttons (or function keys) give immediate auditory feedback, so 
you can easily tell what function you’ve invoked. And because VoiceWalker never modifies your audio 
or video file, you can do no harm with it. For a quick introduction that will have you transcribing in a few 
minutes, see the “Quick Start” section below (§4). 

After you have played with the software for a while, you may find it useful to review this 
documentation, in order to get more out of the software. To give a more detailed picture of what 
VoiceWalker can do, the rest of this document provides a description of all VoiceWalker functions and 
options.
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2. What You Need
Computer

To use VoiceWalker you need a computer with a sound card, speakers or headphones to hear the 
audio, and Windows. (VoiceWalker works with Windows XP, 95/98/Me, 3.1, 2000, NT – almost any 
version of Windows.) VoiceWalker requires a modest amount of hard disk space on your computer for 
the program itself (about 4 megabytes). In addition, you need sufficient space on your computer's hard 
disk (or other computer storage medium, such as CD-ROM, CD-R, CD-RW, DVD, etc.) to accommodate 
the audio and/or video file(s) you want to transcribe.

Recording Files
VoiceWalker works with audio and video recordings in the form of files on your computer. (Note 

that as video formats change over time, VoiceWalker may not work with some newer versions of video 
formats.) So you will need to have your recordings in a digital format appropriate for computer use. For 
audio, this means audio that has either been digitized for use on a computer (in Microsoft .WAV format), 
or was originally recorded in a digital format.  For video, this means video in one of the supported video 
formats (e.g. QuickTime), or video originally recorded digitally (e.g. mini-DV). If the recording you want 
to work with is not yet digitized in a computer format (for example, if it was originally recorded on a 
standard cassette audiotape or videotape), this can be easily remedied—see the section below on 
“Digitizing Your Recordings” (§9).

3. Getting Started
Installing VoiceWalker

To install VoiceWalker, you will need to download the program from the web, expand the file you 
have downloaded using WinZip or a similar program, and start the Setup process. The details are as 
follows:

1. Create a temporary folder on your hard drive.
2. Use your web browser to go to the following web address (URL): 

http://www.linguistics.ucsb.edu/projects/transcription/voicewalker.html
3. Choose which version of VoiceWalker to download: 1.0a or 2.0. (Depending on which version of 

Windows you have, you may find that version 1.0a or 2.0 works better for you.)
4. Click to download the VoiceWalker software (which will be in the form of a zip file). 
5. When the Windows dialog box appears, choose the option to Save the file. (Don’t Open the file, 

i.e. don’t run it remotely.) 
6. Use Winzip (or a similar program) to extract the three files from the vwalker.zip archive, placing 

them in your temporary folder. (Try double-clicking on the vwalker.zip file, which may take care 
of this step automatically.)

7. Go to your temporary folder and locate the file called setup.exe. Double-click on this file.
8. The installation routine will begin. Follow the instructions given.

Appendix A.13 2



Du Bois: VoiceWalker—A discourse transcription utility

9. Finally, delete your temporary folder (along with its contents).
10. You should now find that there is an icon for VoiceWalker on your “Start” menu or “Programs” 

listing. Double-click on the VoiceWalker icon to start the program.

Selecting a File
To start using VoiceWalker, tell it which file on your computer you want to listen to or view. From 

the menu, select File, then Open, then specify the file you need, using the standard Windows dialog box 
that appears. (You may need to try clicking on a drive letter or folder name to get the files you want to 
display.)

4. Quick start: Transcribing with VoiceWalker 
VoiceWalker is actually very simple to use. And because it can do no harm—it only plays back your 

recording, it never modifies it—the best way to learn what it can do is to simply start using it. This 
section describes a few simple steps that will allow you to immediately begin using VoiceWalker in 
coordination with your word processor to transcribe your recordings.

1. Start VoiceWalker by double-clicking on the icon. The program will occupy just a small portion 
of your computer screen. Drag it to the upper part of your computer screen, near the top.

2. In VoiceWalker, select File from the menu, and tell VoiceWalker where to find the audio or 
video recording that you want to transcribe.

3. Now start your preferred word processor (e.g. Microsoft Word, OpenOffice.org Writer, 
WordPad, etc.). Resize its window so that the window fills the lower part of your computer 
screen (i.e. all but the top 20% or so of your screen). 

4. You should now have two windows visible: one for VoiceWalker and one for your word 
processor, with neither overlapping the other.

5. In VoiceWalker, click on the Walk button (the first button on the left). VoiceWalker will start 
playing your recording in bite-size chunks, as it “walks” through the recording one “step” at a 
time.

6. Now switch to your word processor, by clicking on its window. (Or better yet, use the keyboard 
combination Alt-Tab to quickly switch between your two windows.)

7. Go ahead and transcribe what you hear (and what you see, if you're using video).
8. If you need to go back a few seconds in your recording, in order to catch something you've 

missed, switch back to VoiceWalker, using your mouse or the keyboard combination Alt-Tab. 
Then use the “Step Back” function (or whatever other VoiceWalker function you may need).

9. Once you’ve learned what all the buttons do in VoiceWalker, by clicking on them with your 
mouse, you may find it worthwhile to memorize a few keyboard shortcuts in VoiceWalker—
especially the function keys, listed below in §7. This makes the transcribing process easier and 
more efficient, because you can keep your hands on the keyboard the whole time.

10. Don’t forget to save your transcription often, using your word processor.
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5. VoiceWalker Functions
The Walk (F5)

The most distinctive feature in VoiceWalker for controlling the playback of recorded sound is called 
the Walk. The Walk function (F5) plays the recording in manageable chunks so that the transcriber can 
concentrate on transcribing, as it automatically “Walks” through the recording one “Step” at a time. It 
plays a brief sound bite consisting of the first four seconds of the recording (one Step), and repeats this 
portion of audio (and video if applicable) several times to allow the user to transcribe it. Then it steps 
forward slightly, beginning the second Step about one second after the first. It plays this new four-second 
chunk of the recording several times, and then moves on to the third Step. Because each new Step repeats 
part of the material from the previous Step, the transcriber always has enough familiar context to know 
where s/he is in the recording. And because the Walk is entirely automatic, it leaves the user’s hands free 
to transcribe using his/her preferred word processor in a separate window. (See section below on “Using 
VoiceWalker with a Word Processor”.)

The Walk sounds to the transcriber something like the following (assuming the number of “loop” 
repetitions has been set to two):

It’s an interesting thing though, because um, I’m wondering, ... you kno
It’s an interesting thing though, because um, I’m wondering, ... you kno

                            thing though, because um, I’m wondering, ... you know, since it is such
                            thing though, because um, I’m wondering, ... you know, since it is such

                                                                       I’m wondering, ... you know, since it is such ...
                                                                       I’m wondering, ... you know, since it is such ...

... you know, since it is such, ... um,

... you know, since it is such, ... um,

                               it is such, ... um, ... it’s restr
                               it is such, ... um, ... it’s restr

                                                ... um, ... it’s restricted, you have to go through Me
                                                ... um, ... it’s restricted, you have to go through Me

                                                           ... it’s restricted, you have to go through Mexico. ...
                                                           ... it’s restricted, you have to go through Mexico. ...

it’s restricted, you have to go through Mexico. ... (TSK) No. I don’t
it’s restricted, you have to go through Mexico. ... (TSK) No. I don’t

                      you have to go through Mexico. ... (TSK) No. I don’t think so. No.  
                      you have to go through Mexico. ... (TSK) No. I don’t think so. No.
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For some transcription purposes, it is enough to push the Walk button once, after which one can 
spend several minutes at a time transcribing in one’s word processor without having to touch another 
button in VoiceWalker.

Steps
The Walk is composed of Steps. Each Step represents a brief stretch of the recording (by default, 

lasting exactly four seconds) to be played back. Each Step has a specific beginning time and a specific 
ending time. Steps are used in three playback functions (in addition to the Walk function), as follows:

Play Current Step (F7). This function plays one Step of the recording, at the current location 
within the file. Normally this means playing back the most recently played four seconds of the recording. 
This function can be repeated as often as necessary for transcription purposes, and each time it will play 
exactly the same four seconds of the recording. You can play one Step, stop to transcribe or to think 
about what you have heard or seen, and then play precisely the same Step again whenever you are ready.

For an explanation of the time displayed when you press the various Step and other playback 
buttons, see the section below on “Current Time”.

Step Forward (F8). This function shifts the Step forward slightly, allowing the transcriber to 
progress forward at a measured pace through the recording. It shifts forward by one “Offset” (by default, 
this is a distance of 1.1 seconds) and then plays the Step that begins from this new position in the 
recording. For example, if the Step just played was from 10 through 14 seconds, the Step Forward button 
will play from 11.1 through 15.1 seconds.

Step Back (F6). This function shifts the current Step back slightly, allowing the transcriber to 
reposition to an earlier point in the recording, or to review again a section of the recording that went by 
too quickly. It shifts back by one Offset (1.1 seconds) and then plays the Step found at this new position 
in the recording. For example, if the Step just played was from 10 through 14 seconds, the Step Back 
button will play from 8.9 through 12.9 seconds.

If you think about it, the Walk is really just a combination of the Play Current Step function with the 
Step Forward function. You can use the Step Forward and Play Current Step functions to move forward 
through a recording entirely at your own pace, or you can use the Walk function as a kind of automatic 
pilot to do the same thing without the need to keep pushing buttons, allowing you to concentrate on 
transcribing.

Notice that once you have begun a Walk, you can still use the Step Forward and Step Back buttons 
without stopping the “automatic pilot” function of the Walk. For example, you may find that one of the 
Steps went by too quickly for you to transcribe it, so you need to go back and play another repetition of 
it. Pressing the Step Back button will take you back to where you want to be. (You can press it several 
times if you need to move back more than one Offset.) If the Walk is in progress when you do this, it will 
continue automatically. If no Walk is in progress, the Step Back function will just play the specified Step 
and then stop. The same applies to the Step Forward function: you can use it to move forward by one 
Offset during an ongoing Walk, without interrupting the automatic Walk.
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Looping (F2)
Sometimes it is useful to repeat the same part of the recording several times over. The Loop function 

lets you do this automatically, for any of the various Step functions. For example, if you set the number 
of Loops to four, pressing Play Current Step will automatically give you four repetitions of the current 
Step. Similarly, the Walk will repeat each Step four times before going on to the next Step. The Step 
Forward or Step Back functions shift forward or back as usual, and then play four repetitions of the 
relevant Step.

The default number of Loop Repetitions is set to two. You can change this number by clicking the 
arrows under the Loop display. And you can turn Looping on and off by clicking the Loop Toggle button 
(or press F2).

Looping only operates in conjunction with the various Step functions (Walk, Play Current Step, Step 
Forward, Step Back). It has no effect on the Play or Jump functions (described below).

Play (F4)
The Play function plays continuously beginning from the present location in the recording as 

displayed in the Current Time window. It works like the Play button on any ordinary audio or video 
playback machine.

Stop (F3)
The Stop function stops all playback. It works like the Stop button on any ordinary audio or video 

playback machine. It doesn’t matter whether playback was initiated by the Play button, or the Walk 
button, or any of the other functions that play the recording: the Stop button will stop it.

Jump
The Jump functions are designed to move around to different locations in the recording a little faster 

than the Step Back and Step Forward functions.

Jump Forward moves forward one entire Step (not one Offset) from the Current Time position in 
the recording, and then plays the Step located at the new position. For example, if the Current Time is at 
now 10 seconds, pressing Jump Forward will move the Current Time to 14 seconds, and then play the 
Step that ends at 14 seconds.

Jump Back moves back one entire Step from the Current Time position in the recording, and then 
plays the Step located at the new position. For example, if the Current Time is now at 10 seconds, 
pressing Jump Back will move the Current Time to 6 seconds, and then play the Step that ends at 6 
seconds.

Because the Jump buttons always begin playing the recording as soon as you move to the new 
position, you can use Jump Forward and Jump Back to quickly find the place in the file that you are 
interested in, pressing them as often and as rapidly as necessary to move in the direction you wish.
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Current Time
When the Play button is pressed, the Current Time window (above the Time Slider) shows the time 

of the recording currently being played, in the format 00:00:00:00, which represents 
HOURS:MINUTES:SECONDS:HUNDREDTHS. The Time Slider bar moves along automatically 
during playback, from left to right, to graphically represent the location, relative to the whole file, of the 
time currently being played.

Note that whenever a Step is being played, the time displayed as the Current Time always represents 
the end of the current Step. This is near the actual time that is currently being played -- that is, within one 
Step’s distance of the actual time -- but is not identical to it. During the period that a given Step is 
playing, the Current Time display does not change. As soon as you begin each new Step (whether by 
pressing Walk, Step Forward, Step Back, or a Jump button), its endpoint will be displayed as the new 
Current Time. Thus, in Walk mode, the Current Time changes only when you progress from one Step to 
the next, increasing each time by the fixed increment of one Offset (by default 1.1 seconds.)

Suppose you are at the very beginning of your recording, with the Current Time displayed as 
00:00:00:00. If you press Play Current Step (F7), playback will start at 0 seconds and continue up to 4 
seconds, where it stops. But the Current Time display will show 4 seconds (displayed as 00:00:04:00) 
during the entire period. If you press Walk (F5), the Current Time display will first show 4 seconds, as it 
plays Step 1, then 5.1 seconds as it plays Step 2, then 6.2, 7.3, 8.4, and so on as each new Step begins.

Note that when the Stop button is pushed, the Current Time window will display whatever time it 
displayed at the moment Stop was invoked.

You can move to any location in your recording by either of two means. You can use the mouse to 
drag the Time Slider bar to wherever you want it, and release it. The time corresponding to the new Time 
Slider position will appear in the Current Time window. Or, you can type the time you want directly into 
the Current Time window, using the same time format 
(HOURS:MINUTES:SECONDS:HUNDREDTHS). You can also just type in the number of seconds. 
Thus, typing 66.3 will be understood as one minute and 6.3 seconds (displayed by VoiceWalker as 
00:00:06.30).

Notice that you can use the Time Slider to move to a new time even during a Walk, and the Walk 
will automatically continue from the new time position without interruption. You can do the same during 
Play function, and playback will likewise continue from the new location without stopping.

VoiceWalker will automatically remember your time location in a given audio or video file after you 
close the program. Next time you begin a session working on the same file, the time slider will be in the 
same location, so that pressing Play picks up where you left off in your previous work session.

Volume
Playback volume can be adjusted within VoiceWalker via two small buttons just to the right of the 

Time Slider. Click on the up-arrow and hold it down to raise the playback volume. Click and hold the 
down-arrow to lower the playback volume. As you do this, a small bar that appears on the status bar (if 
this is displayed) will become longer or shorter to show you how much the volume is being raised or 
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lowered.

The VoiceWalker volume control does not obviate the need to set your preferred playback volume 
within Windows. You will still want to set the appropriate overall level for your computer using the 
Windows controls (e.g. under Settings/Control Panel/Multimedia). We recommend you click the box for 
“show volume control on the taskbar”, for convenience in adjusting playback volume as needed.

Time Stamp (F12)
The time stamp function is designed to help you insert time information into your transcription, if 

you so desire. When you press the Time Stamp button (F12), VoiceWalker records the Current Time of 
the audio or video playback, and copies this time into the Windows Clipboard. You can then switch into 
your word processor and press Paste (or Ctrl-V) to insert the information into your transcription at the 
relevant place.

6. Menus
All of VoiceWalker’s functions are available from menus. Of course, usually it’s easier and more 

efficient to click the buttons—or even better, to use the function keys (see below). VoiceWalker’s main 
menu has five groups: File, Play, Options, Video, Help.

File Menu
The File menu lets you select a new file to work with at any time. Select File, then Open, and a 

standard Windows dialog box will appear to allow you to specify the file you want. (Or use the keyboard 
shortcut Ctrl-O.)

To see general information about the file you have selected, choose File, then Info. This displays 
the name and path of the file you are working with, along with various technical details about the file 
(sample rate, number of bits, stereo versus mono, and total running time for the file).

To quit using VoiceWalker, select File, then Exit (or press Ctrl-Q). Or use the standard Windows 
way to close the program.

Play Menu
Play. All the playback functions of VoiceWalker can be accessed from the Play menu. Select Play, 

then choose the appropriate playback function. But there is not much reason to use this menu, as it is far 
more convenient to use the various playback buttons, or better still, the function keys (see below).

Go to time (F11) is a very useful function that can be accessed from this menu (or via the F11 
function key). Pressing the Go to Time button brings up a dialog box which allows the user to type in a 
time; then the Current Time will shift to the specified location in the recording. The time is normally 
specified in the format 00:00:00:00, representing HOURS:MINUTES:SECONDS:HUNDREDTHS. 
(Note that this time-setting function is also available on the main VoiceWalker panel, in the Time Slider 
box.) For convenience you can also just type in the number of seconds (for example, typing 127 will be 
understood as 2 minutes and 7 seconds, displayed as 00:02:07:00).
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Options Menu
The Options menu allows users to specify various settings. Most transcribers seem to use the 

factory default settings given by VoiceWalker, without ever needing to modify them. If this is all you 
need, you can ignore this section. But the settings can all be modified, if needed for special purposes. 
Any modified Options settings will be in effect during the current session using VoiceWalker with a 
given audio or video file. All Options settings are reset to the factory defaults when you leave the 
program, or when you open a new file.

Note that all times for the settings are given in the same format: 00:00:00:00, representing 
HOURS:MINUTES:SECONDS:HUNDREDTHS.

Step Duration lets you specify ho long a stretch of recording to play for each Step. The default is 
four seconds (00:00:04:00). This seems to be about the right amount of sound to allow the transcriber to 
take in what is being said, as well as to provide enough context to see the relation to previously 
transcribed utterances.

Offset Time lets you specify how far to “offset” the beginning of each Forward Step from the 
beginning of the previous Step. The default is 1.1 seconds (00:00:01:10). This in effect specifies how 
much new information the transcriber will take in with each new (Forward) Step. Note that because the 
default Offset Time is significantly smaller than the default Step Duration, there is a substantial portion 
of the playback that is shared between one Step and the next. This is helpful in allowing the transcriber to 
retain a sense of where s/he is in relation to previously heard portions of the recording.

Rest Time specifies the amount of time to pause between Loops during Looping, or between Steps 
during a Walk. In other words, it represents a brief silence inserted between successive repetitions or 
successive Steps (like a “rest” in music). This avoids the overly insistent, breathless character of 
immediate repetitions with no pause in between them, which can be stressful for transcribers. The default 
Rest Time is 0.6 seconds (00:00:00:60).

Loop Repetitions specifies the number of times to repeat each Step, as occurs in the various Step 
functions (Walk, Play Current Step, Step Forward, Step Back). The default number of Loops is two. This 
is the one option that transcribers do often like to modify, but there’s no need to use this menu to do so: it 
can be directly accessed on the main VoiceWalker panel, using the arrows under the box that displays the 
number of Loop repetitions.

Status Bar lets you choose whether to display or hide the Status Bar help information. To find out 
what any given button does in VoiceWalker, place your cursor over the button. A brief description of the 
button’s function will be displayed on the Status Bar, at the bottom of the VoiceWalker window (see 
Help below). Selecting this menu item will toggle display of the Status Bar on or off.

Video
The Video menu selection lets you specify what size of window will be created by VoiceWalker for 

viewing video playback. (Note that as video formats change over time, VoiceWalker may not work with 
some newer versions of video formats.) 

Appendix A.13 9



Du Bois: VoiceWalker—A discourse transcription utility

BookMarks
VoiceWalker allows you to “bookmark” up to four locations in the audio or video file you are 

working on. From the Options menu, select View Bookmarks (or press Ctrl-B), and the VoiceWalker 
window will enlarge to reveal a display of four bookmarks. Each bookmark has three buttons. As you 
play back your file, press the first button to set the beginning of the bookmarked location. When the 
playback reaches the point where you want your selection to end, press the third button to mark the 
endpoint of the bookmarked location. To play the section you have just bookmarked, press the middle 
button (“Play Bookmark”).

You can use this function to compare two or more different portions of your recording. Set up the 
bookmarks you want, then click in turn on the “play” button for each bookmark to make your 
comparison.

VoiceWalker will automatically remember the locations that you have bookmarked in a given audio 
or video file after you close the program. The next time you begin a session working with the same file, 
your previous bookmarks will be available for your use. If you want to clear the bookmarks (erase them), 
you must specify Clear Bookmarks from the Options menu.

7. Function Keys
By far the most convenient and efficient way to use VoiceWalker is not to use the mouse at all (or to 

use it minimally), but to instead control all playback functions via the keyboard, using the function keys. 
This allows the transcriber using a word processor to keep his or her hands on the keyboard as much as 
possible. The following list presents a summary of the most commonly used functions each of which can 
be accessed via a particular function key. Note that all the functions listed here are also available by via 
the mouse, by clicking the button icons on the main VoiceWalker panel. A full description of what each 
function listed here actually does is given in the relevant section above.

Key Function
F1 Help
F2 Looping On/Off
F3 Stop
F4 Play
F5 Walk
F6 Step Back
F7 Play Current Step
F8 Step Forward
(F9)* Jump Back
(F10)* Jump Forward
F11 Go to Time
F12 Time Stamp

* not currently implemented
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8. Using VoiceWalker with a Word Processor
Although VoiceWalker can be used just to play back an audio or video file, more often it is used for 

transcribing. VoiceWalker has been designed to work in conjunction with any word processor you like: 
Microsoft Word, OpenOffice.org Writer, WordPerfect, WordPad, or any other Windows program you 
prefer to use. The following discussion repeats much of the information given above in the “Quick Start” 
section (§4), with a little more detail.

First open VoiceWalker in one window, then open your favorite word processor in a separate 
window. Resize each window so that you can see both programs at once on your screen. (This should be 
easy because VoiceWalker takes up very little space on your screen.) You can now control both 
programs, using the functions of VoiceWalker for audio and video playback, and using your word 
processor for typing and editing the transcription.

For example, first press the “Walk” button in VoiceWalker to put the playback on “automatic pilot”. 
Then click on your word processor window, and type the words you are hearing. VoiceWalker will 
continue to play back sound and video “in the background”, even though your active window is now the 
word processor. Depending on your transcribing style, you may be able to transcribe for several minutes 
in this way without having to push another button in VoiceWalker.

But most people will want to use the VoiceWalker controls more often: for example, to repeat the 
playback of a section that went by too fast to transcribe the first time. To do this you will have to switch 
between the two programs. The quickest way to do this is to use the keyboard, using the keyboard 
combination Alt-Tab to switch between the two programs. (We recommend that you close all other 
windows except these two, leaving just the VoiceWalker and word processor windows open. That way, a 
single press of Alt-Tab will switch you reliably from one program to the other.) 

For example, assume you are typing in your word processor, while VoiceWalker is playing in 
“Walk” mode in the background. You want VoiceWalker to “Step Back” in the recording because you 
missed a few words. To do this, type the Alt-Tab key combination followed by the F6 function key. This 
sequence will first shift you into the VoiceWalker window, and then perform the “Step Back” function. 
Then type Alt-Tab a second time, and you are back in your word processor, ready to continue typing. 
You never have to raise your hands from the keyboard. After a little while the three-stroke sequence 
“Alt-Tab ... F6 ... Alt-Tab” becomes rapid and automatic. Almost every function of VoiceWalker can be 
accessed in this way with just a few keystrokes, where a function key is the middle part of an “Alt-Tab 
sandwich.” The function keys that are probably the handiest to use in this way are the following:

F6 “Step Back”
F7 “Play Current Step”
F8 “Step Forward”

With a few simple Alt-Tab sequences memorized, you can get most of what you need from 
VoiceWalker without having to stop to reach for the mouse.
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9. Digitizing Your Recordings
Audio

Creating digitized audio files, in order to transcribe them using VoiceWalker, is not much more 
difficult than copying from one tape recorder to another. In this case, though, the second “tape recorder” 
is your computer and its hard disk. In broad outline, it typically works as follows: You run an audio cable 
from your existing audio recorder (“Line Out” or “Phone”) to the sound card on the back of your 
computer (“Line In” or “Record”). On your computer, you open your sound recording software (e.g. 
Sony Digital Media’s Sound Forge, etc.), and press the Record button in your software. On your tape 
recorder, you then push the play button. You are now recording from the tape recorder onto your 
computer’s hard disk. When you have recorded as much as you want to record, stop the tape recorder, 
and “stop” the software. That’s it. You should now have a sound file that you can use with VoiceWalker.

VoiceWalker requires the Windows .WAV format, so be sure to use this format. We recommend 
using a “CD-quality” recording format to get very good sound quality. This means choosing a sampling 
rate of 44.1 kHz, 16-bits, and stereo. This format requires 10.5 megabytes of hard disk storage space per 
minute of sound. You can economize on disk space by going down to  22.05 kHz for the sampling rate, 
with still very good quality. (You could try to save still more on storage space by using a lower sampling 
rate or 11 kHz, and even lowering the resolution to 8-bits, but the sound quality will start to suffer 
significantly.) Note that stereo is very important for dealing with spontaneous conversation, because it 
contributes greatly to the accuracy of hearing simultaneous or overlapping speech. Stereo should be 
considered a necessity rather than a luxury for working with natural conversation.  

Better than digitizing your recordings is to record them digitally in the first place. This becoming 
much easier with the rapid development of new technologies, such as portable hard disk recorders that 
record directly in .WAV computer format, and make the transfer to your computer’s hard disk with a 
standard USB computer cable (e.g. iRiver H-120 or H-140).

For a full description of the audio digitizing process, please refer to the documentation that comes 
with your multimedia computer or your sound card, or with the sound recording software that is typically 
included with the purchase of a computer or sound card.

Video
The easiest way to get a video recording into a computer format that is easy to work with is to make 

the recording in a digital video format to begin with. Currently the best way to do this for most people 
will be to use a mini-DV video camera, coupled with an inexpensive DV video-capture card..

The process of creating a digitized video file from a VHS videocassette or other analogue video 
source is roughly comparable to that described above for digitizing an audio file. However, to digitize 
analogue video recordings, the process tends to be more complex. It usually requires more specialized 
equipment, and the details may vary substantially according to the specifics of your video equipment, 
digitizing card, and so on. If you go this route, please refer to the documentation provided with your 
equipment. 
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10.Help
To get a brief description of any button on the VoiceWalker panel, move the cursor to what you are 

interested in, and a description will appear in the Help Status Bar at the bottom of the VoiceWalker 
window. (You can choose whether to display or hide this Help Status Bar, using the Options menu as 
described above.)

At present, the Help menu (or F1 key) provides little in the way of substantive information. The role 
of Help is best served by the Status Bar, plus this manual.

11.About VoiceWalker
Versions

There are currently two versions of VoiceWalker, which have nearly identical functions, structure, 
and look-and-feel. Despite the earlier number, version 1.0a may be best for most users. Some users may 
need to use version 2.0, which however is not as fully tested, and may differ in some minor details from 
the functions as described in this document. (See “Credits” section below for further information.)

Documentation
Documentation is available at the VoiceWalker website, at:

http://www.linguistics.ucsb.edu/projects/transcription/voicewalker.html

Since the documentation on the website is simply a version of the present document, you should 
check the revision date to see if the version you have is up-to-date (see the date at the end of this 
document).

Credits
VoiceWalker was created as a spin-off from the Santa Barbara Corpus of Spoken American English, 

at the Linguistics Department of the University of California, Santa Barbara. VoiceWalker was designed 
by John W. Du Bois. Programming and design refinements are by Simon H. Corston and Gary Holton, 
partly based on prototypes by Robert Norris. The original program (VoiceWalker 1) was written using 
SumTotal’s (formerly Click2Learn and Asymetrix) ToolBook II authoring software. VoiceWalker 2 was 
entirely recoded by Gary Holton, using different software. Documentation is by John W. Du Bois.

Copyright
VoiceWalker is Copyright ©1998 by the University of California Regents. 

VoiceWalker documentation is Copyright ©2006 by John W. Du Bois. 

VoiceWalker is free for noncommercial use (as shareware). Support is not available. For further 
information, contact:
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John W. Du Bois, Director
Santa Barbara Corpus of Spoken American English
Linguistics Department
University of California, Santa Barbara
Santa Barbara, California 93106
USA

[Rev. 25-Aug-2006]
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